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Quick Start
 
For those who can't wait to get started, simply start the program and when the main screen appears, click on the Get 
Program button on the left of the screen. 
 
(The first time you use a particular month's CD, the program will start by displaying a text windows with the latest 
news from PsL. On subsequent accesses of the same CD, this window will not display unless you click on the File 
menu and then on "PsL News".) 
 
When you click on Get Program, the program will start with the first Section, Category, and Subcategory in DOS. 
Click the Next and Prior buttons to view all the write-ups in order by type of program. 
 
When the end of the selected subcategory is reached, the program will continue on to the next subcategory, so you 
can continue through the entire set of new programs for the month if you wish. 
 
Note: If you intend to bypass the reading of the rest of this Help file, at least run the brief Tutor (on the menu bar) 
before calling for help. 



Introduction
 
The PsL Database contains write-ups of...
 
1. The New and Updated Programs: 
 
          Each month we receive over 1200 new and updated programs. Regardless of the section of the month being 
featured on the CD, the new/updated programs can include every type of program we carry (games, business, 
utilities, etc.) for DOS, Windows and OS/2. We test, review and organize these programs and put them on the 
monthly CD-ROM. The rapid, low-cost distribution of the latest pd/shareware to users was originally the sole 
purpose of the PsL Monthly CD-ROM, but we later added a Section of the Month. 
 
2. The Section of the Month: 
 
          Each month we put a section of our complete library on the Monthly CD-ROM, in addition to the new/updated 
programs. Over a eight-month period, our entire library appears on CD, then the cycle repeats. When a category 
repeats, it is updated for the thousands of new/updated programs received during the previous eight months since the
category last appeared. 
 
3. The Complete PsL Collection: 
 
          Although it takes eight CDs to hold the entire PsL, the Shareware Database on each month's CD contains the 
write-ups of the entire library. When you search for a program, if it is not on the current CD, the program will tell 
you which CD it is on. 
 
NOTE: To install a program which is not on the current CD, you have to quit this program, change CDs, and run the 
access program for that CD, or you can make a note of the directory the desired file is in and after changing CDs, 
manually un-Zip and install the program.    



Searching & Browsing by CD Date and/or 
Program Type
 
The PsL CD-ROM Shareware Database contains write-ups of over 20,000 programs spread over eight CDs. To limit 
your searching and browsing to just the files on the current CD-ROM, click on "CD Date+Type" under "Browse By"
at the top-right of the program window. To search the ENTIRE database, click on "Program Type". 
 
On the left side of the window are four drop-down list boxes with which you can select the Operating System, 
Section, Category, and Subcategory to use when you begin viewing the database. 
 
For example, if you are looking for a Hearts game for Windows, you can select "Windows" in the Operating System 
list box, "Games" in the Section list, "Card Games" in the Category list, and "Hearts" in the Subcategory list. Then 
select Browse By "CD Date+Type" to search the current CD only or just "Program Type" to search all CDs, then 
click on "Get Program". 
 
The program will display the first entry found in that subcategory. From there, you can use the Next and Prior 
buttons to page through the database. When the end of the selected subcategory is reached, the program will 
continue on to the next subcategory so that you may easily browse the database. 
 
At any time, you may select and jump to a new Operating System, Section, Category, or Subcategory. Because the 
Sections are not identical for each Operating System and the Categories are not identical for each Section, etc., if 
you change a higher box, you must also re-select the boxes below it. 
 
For example, if you are looking at WINDOWS, GAMES, CARDS, HEARTS and want to look at Hearts games for 
DOS, you must first select DOS, then select GAMES in the next box, then CARDS in the next, then HEARTS in the
next. 
 
For information about how to narrow the search of the current CD-ROM to just new programs, just updated 
programs, or just the Section of the Month, see Narrowing the CD Search 



Narrowing the CD Search
 
On each CD are three classes of programs, New programs, Updates, and the Section of the Month. When "CD Date 
+ Type" is selected, you can further restrict your searching/browsing to one of these three classes at a time by 
selecting the appropriate option under the "File" menu. 
 
Normally, subscribers will first want to view just the New Programs. You can start with the first category under DOS
and browse through the whole database for the month, or click on the category boxes to jump to a specific category. 
 
The New Programs and Updated Programs menu options take effect only when you are browsing the catalog by CD 
Date + Category (the first option above the Get Program button). These options are grayed out when any other 
"Browse By" method is chosen. 



Searching & Browsing by Program Name
 
 
              1. Select "Program Name" under "Browse By". 
 
              2. Press Ctrl-K to clear the screen. 
 
              3. Type in all or part of the program name. 
 
              4. Click on the Get Program button. 
 
Use the Prior and Next buttons to browse by program name if you do not get an immediate hit on the program for 
which you are searching. 



Searching & Browsing by File Name
 
 
              1. Select "File Name" under "Browse By". 
 
              2. Press Ctrl-K to clear the screen. 
 
              3. Type in all or part of the file name. 
 
              4. Click on the Get Program button. 
 
Use the Prior and Next buttons to browse by file name if you do not get an immediate hit on the program for which 
you are searching. (Note: wild cards are not supported.) 



Searching & Browsing by Key Word
 
The "Key Word(s)" box (beneath the "Get Program" button) provides a way of searching for a specific type of 
program without having to figure out the Section, Category, and Subcategory it might be in: 
 
              1. Select "Key Word" under "Browse By". 
 
              2. Press Ctrl-K to clear the screen. 
 
              3. Type in all or part of the key word(s). 
 
              4. Click on the Get Program button. 
 
Click on the Prior and Next buttons to page by Key word. Also, note the category and subcategory is shown for the 
matching entry. Since Key word assignment is not as regimented as category assignment, once you find the 
category, it may be more reliable to click on the Program Type line and the Get Program button and then Prior/Next 
to page through entries. In fact, we often use somewhat different key words for the same types of programs to make 
it easier to locate a program of the desired type with the expectation that the user will then switch to a category 
search. 
 
You can search the category fields by clicking on the File menu and the Category List option. This may be even 
more reliable than a Key word search since a Category List search will look for words embedded in descriptions and
a Key word search only looks for Key words which start with the specified text. 
For an even more reliable, though slower, search method, see "Search Descriptions". 
 



Searching & Browsing by Author
 
NOTE: To minimize the amount of non-essential information which appears on the screen, author information is not 
shown for each program unless that feature is turned on. To turn on the author info display, click on "Author" on the 
menu bar and then on "Show Author". 
 
To search for a particular author, type the author's last name in the Last Name field and first name in the First Name 
field and click on the Find Author button. Use the Prior Auth and Next Auth buttons to browse the author database. 
 
To search for an author by company name, make sure the Last Name field is blank and enter the company name in 
the Company Name box and click on the Find Author button. Use the Prior Auth and Next Auth buttons to browse 
the author database. 
 
After locating an author, you can browse through all the programs by that author. Above the Get Program button, 
click on the Author/Co. line, then click on the Get Program button. Use the Prior and Next buttons (NOT the Next 
Auth and Prior Auth buttons) to browse all the programs by this author. 
 
Also see Viewing the Author List. 



Viewing the Author List
 
You may find it easier to scan a list of authors than to page through them an author at a time. If so, click on the Edit 
menu, click on Author, click on Show Author List, and then click on the way you want the list sorted. 
 
To remove the list, use the same procedure you went through to bring up the list. 
 
Because over 10,000 authors are in the PsL database, we limit the display to the names starting with one letter of the 
alphabet at a time. If you have an author's name displayed before bringing up the list, the first letter of that name will
be the list displayed. Otherwise, you can simply type in a letter. (Don't forget to make it uppercase unless you really 
want names starting with the lowercased letter.) 
 
Once the list is displayed, you can page through the author database by letter by clicking on the Prior Auth. and Next
Auth. buttons. 
 
To select a name from the list, double-click on it. Once a name is selected, you can use the "Browse By" - 
"Author/Co." option to find all the. programs written by that author/company. 



Searching Descriptions
 
Because this search works by loading one program entry after another to search, it can be especially slow when run 
from the CD. The trade-off to this being slow is that it is the most thorough way to search the database. 
 
If you have sufficient hard disk space, you can make a PSL_NEWS directory on your hard disk and copy the 
contents of the PSL_NEWS directory on the CD to it, then run PSL_SHRW.EXE from your hard disk. 
 
 
HOW TO SEARCH: 
 
The type and order of entries to be searched is based on the most recent search you have done, so follow these steps:
 
      1. Click on the Browse-By method you want to use. Searches cover the entire PsL library, not just the programs 
on the current/specified CD, except for the "Current CD & Type" option. 
 
            - CD Date & Type [of program] 
            - Program Type 
            - Program Name 
            - File Name 
            - Author/Company Name 
            - Key Word 
 
      2. Hold down the Ctrl key and press K to clear the screen. 
 
      3. Enter the criteria which will bring up the entry from which you you want the search to start. For example, 
 
            - to search by type of program, select the Operating System and Section using the drop-down list boxes. 
 
            - to search by program name, enter the first letter(s) for the search to start with, etc. 
 
            Enter as little text as possible which will still narrow the search. For example, if you enter "hobby" for a Key 
Word search, you could miss entries with "hobbies", so you should enter "hobb". 
 
      4. Click on the "Get Program" button to get the first entry. 
 
      5. You are now ready to start the search, so click on the Edit Menu and Search option in that menu or press Ctrl-
S. 
 
      6. When prompted, enter the text to search for. The search is NOT case-sensitive, so capitalization doesn't matter. 
Text can be any keyboard characters (e.g.: punctuation, numbers), NOT just alphabetic characters. 
 
You will see program entries flashing by on the screen. They will stop either when an entry with the specified text 
has been found or when there are no more entries in the "selected search area". 
 
For searches by program type, the selected search area is the specifed Operating System + Section (e.g.: Windows-
Games, DOS-Graphics). 
 
For searches by name, the selected search area contains all entries starting with the same first letter. 
 
 You can continue the search using the ending point as the next starting point by pressing F3 or clicking on the Edit 
menu and "Get Next Match". 
 
You can cancel a search at any time by pressing Ctrl-S again. 



Viewing Screen Shots
 
A number of the new/updated programs for the month have screen shots of the program on the CD. If the Show 
Screen button is grayed-out, there is no screen shot for the program. If it is NOT grayed-out, there is a screen shot on
the CD and you may view it by clicking on the button. 
 
Viewing screen shots is a nice plus unique to PsL's shareware CDs. They allow you to see what a program looks like
without having to first install it. Many times a single screen shot can tell you more about a program than the the 
write-up does. 
 
Because of the amount of disk space used by screen shots, we limit them to only the new/updated programs and only
the ones of those for which we think the screen shot adds significantly to the write-up. 



Installing Programs
 
IMPORTANT: Before trying to install a program, check the CD & Path date box to make sure that the program is on
the current CD. If it is not, you must quit this program, change CDs, and either run the access program for that CD 
or manually un-ZIP the file to your hard disk. 
 
After finding and displaying a program you wish to install, click on the Install button. Use the drive and directory 
boxes to select where you want the program installed. (The file box is shown just so that you can see the files 
already in the directories.) You can create a new directory if you wish. 
 
After you have selected a drive and directory, click Install. The program will be dearchived from the CD-ROM to 
the selected path. 
 
Files for each program on the PsL CD are combined into an archive file to keep them from getting mixed up with the
files from other programs. The PsL program dearchives these files to your selected directory. However, it is not 
uncommon that in these sets of files for a program is an installation program which must also be run. 
 
We are frequently asked why the user must go through two installations in cases like this. The answer is that many 
authors require the distribution of their programs in this manner and we must comply. 



Viewing the Category List
 
In the Edit menu, you can select Category Maintenance which will let you see a list of the Sections, Categories, and 
Subcategories for DOS, Windows and OS/2. It also includes detailed descriptions for many of the classifications. 
 
This listing may make it easier for you to get an overview of all the categories available in the database; however, 
you cannot add, edit or delete entries while the files are on the CD. For information about updating the list, see 
Entering/Changing Data. 



Entering/Changing Data
 
You can use the PsL PD/Shareware Database program for keeping track of other programs. However, since you 
cannot write to a CD-ROM, to store new or edited entries, you must copy the database and the software to your hard
disk. 
 
There is no complicated set-up necessary. Simply create a directory on your hard disk named PSL_NEWS and copy 
the contents of the CD's PSL_NEWS directory to it, then run PSL_SHRW.EXE from that directory on your hard 
disk. 
 
When deleting an author or a category, you will be asked for the category code or author number to assign to 
programs which reference the entry being deleted. So before deleting a category or author, write down the code or 
number of the category or author which will take its place. 
 
Since this program is being distributed as a look-up tool and we do not know if anyone has any interest in creating 
their own database with it, we are not going to take up a lot of time and space explaining the editing functions, 
which should be pretty self-explanatory anyway. If you need more help, call PsL Tech Support at 713-524-6394, 
8:30 a.m. to 5:00 p.m. Central time, Monday-Thursday, 8:30 a.m. to 12:30 p.m. Fridays. 



Copy Author Address to Clipboard
 
This option copies the author's name and/or company name and mailing address to the Windows Clipboard. From 
there, you can paste it into Notepad or your database program or any other program to use however you wish. (This 
feature is for individual users' personal use. For extracting portions of the author mailing list for commercial 
purposes, contact PsL.) 
 
NOTE: A carriage return and line feed are added to the end of each line of the author's address. This will cause the 
address to appear correctly in most Windows apps, but in some, this may cause a blank line to appear between each 
line. In the latter case, you will have to delete the blank lines. 



Technical Program Info
 
Below are descriptions of check boxes which may be of interest only to those with more esoteric needs: 
 
"ASP Mem." - Author is a member of the Association of Shareware Professionals, the primary trade association for 
the shareware industry. ASP membership provides assurance that the author is still active and supporting the 
software. ASP members must abide by standards which provide protection for the user. 
 
"Permission Required" - The author requires permission for redistribution of his program. 
 
"ASP Ok" - The author requires permission for redistribution, but gives automatic permission to vendor-members 
and BBS-members of the Association of Shareware Professionals. 
 
"Update" - The program on this CD is an update. If you are using an earlier version, or did not use an earlier version 
due to problems with the program, check the authors' documentation for new features and bug fixes. 
 
"Demo" - This program has significant limitations which may not allow it to be fully evaluated. If a program has 
limitations to the shareware version which, in our opinion, do not inhibit the reasonable evaluation of the program, 
we do NOT check the Demo box. 
 
While we do put "Demos" on the monthly CD when new, our policy is NOT to carry demos onto future CDs in the 
Section of the Month. 






